
 

FIELD TECHNICAL PROCEDURE 
Document #:  FTP-00276, Rev. B 
Issue Date:  December 5, 2013 

Printers Affected:  All White-equipped Vutek and Wide 
format printers  

 

File Preparation for White Ink 
This document provides comprehensive instructions for preparing files for use with 
white ink.  You can use white ink in many useful and creative ways—as a solid area, 
or as a tint or gradation. Some spot and shape white printing require prepress 
preparation, but some uses do not. The prepress procedures are not complicated, 
but you must do them in a specific manner to ensure successful printing. 

Before Starting 
It is important to understand the entire file preparation process before you start, 
so please read through this entire document before preparing the White_Ink 
file. 
 

•  Read through this entire document before beginning any of the procedures. 
•  You should be familiar with the entire file preparation process before 

continuing. 

Overview: Preparing files for white ink 
Preparing files for white ink requires that you first understand the process, perform prepress 
preparation, and then set up and save or export the files. 
 
This is the workflow you follow when preparing files for white ink:  

1. Understand the three categories of white ink processing. For details, see 
Understanding the three modes of applying white ink. 

2. Complete prepress work needed to create white ink data. The procedure 
depends on which application you are using. For details, see Prepress 
procedures for creating white ink data. 

3. Prepare files that you want to save or export. The procedure depends on 
which application you are using. For details, see Preparing files for saving as 
PDF. 

4. Save the files. When you set print options for the file, you can also export the 
file and save it as a preset. For details, see Saving files as PDF. 
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Understanding the three modes of applying white ink 
There are three modes for ways to apply white ink—flood, shape, and spot white. Shape and Spot 
White have similar preparation, so they are discussed as one mode. 

Flood mode 
With flood, the dimensions of the files determine the dimensions of the area to be 
coated.  Flood does not require prepress intervention because the operator applies 
the flood at the printer. 
 

Note: When printing a flood, the flood area is larger than the image file. 

Shape and spot white modes 
Shape and spot white are applied to the substrate during prepress work. Preparing 
files for shape and spot white is the same. Whether to apply white on top of or 
under the CMYK is determined at the printer. 

Note: Spot White mode prints CMYK ink and white ink simultaneously. 
In any areas where white intersects CMYK data, white and CMYK 
inks will blend together when printed. 

Prepress procedures for creating white ink data 
In normal printing, white data areas in image files are translated as <none> or the 
absence of ink. The white paper, or ground, serves as white in process printing. 
 
For white ink prepress processing, you must type the name White_Ink. This naming 
convention is important.  Be sure to include upper-case and underscore usage. XF 
automatically recognizes spot channels called White_Ink as data used for white ink 
printing. 

Using Adobe Photoshop CS Series for shape and spot white 
To utilize the white ink function in a Photoshop file, you must create a spot color 
channel. To do this, make and save a selection as a spot channel. RGB and CMYK 
files are acceptable. 
 

1. Use normal selection tools (Wand, Lasso, Quick Mask, Color Range, etc.) to 
select the areas of the document that you want to contain white. 

2. Choose Select > Save Selection. (See Figure 1.) 
3. Name the new channel White_Ink. (See Figure 2). 
4. Open the Channel Palette under Window > Channels. 
5. Double-click the name of the new channel to open the Channel Options 

dialog box. (See Figure 3.) 
6. Click Spot Color in the Color Indicates group box.  
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Figure 1: Select > Save Selection Screen 

 

Figure 2: New Channel – White_Ink Screen 

 

  

Figure 3: Channel Options – Spot Color 

 
 

7. Save the document as a PDF file with spot colors checked ON (See 
Preparing files for saving as PDF). 

 

Using Adobe Photoshop CS Series for white only image 
Preparing for a white-only image differs from preparing for shape and shape spot 
white.  
 

1. Open an image.  

Note: RGB and CMYK files are acceptable. 

2. Choose Image>Mode>Grayscale. (See Figure 4.) 
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Figure 4: Choose grayscale mode 

 
 

1. Choose Window>Channels >Channel Palette.  
2. There is a single channel called Gray. 
3. Choose Duplicate channel from the palette menu. (See Figure 5.)  
4. Name the new Spot Channel White_Ink. (See Figure 6.) 

Figure 5: Duplicate channel 

 
 

Figure 6: Name spot channel White_Ink 

 
Check Invert 
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5. Click the Invert checkbox, and then check OK. 

Remember that the black/gray area of the image will print white. 
6. Double-click the name of the new channel to open the Channel Options 

dialog box. Click Spot Color in the Color indicates pane. (See Figure 7.) 

Figure 7: Channel Options 

 
 

6. Click the Gray channel in the Channel Palette.  
7. Choose Select>Select All, and then choose Edit>Clear. 

This removes the data from the Gray channel. (See Figure 8). 

Figure 8: Clear the data 
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8. Make sure that Spot Colors is on, and then save the file as a PDF.  

Using Adobe Illustrator CS Series for shape and spot white 
If you use the white ink function in Illustrator, you must define the areas of white 
ink in the file. 
 

1. Choose Window>Swatches.  
2. From the swatches palette menu, choose New Swatch. (See Figure 9.) 
3. Set Color Type to Spot Color, and the Mode to CMYK. 
4. Name the new swatch White_Ink. 
5. For easy identification, set the swatch color to a color not used in the file. 

As an example, you can use 100% Magenta. This color will translate as white ink 
at the RIP. (See Figure 9.) 

Figure 9: New Swatch - White_Ink 
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6. In the file, select the shapes and elements to receive white ink coverage. (See 
Figure 10.) 

Figure 10: Apply Spot Color - White_Ink 

 
 

7. With the element selected, change the fill to the White_ink spot color. 

Important: White_Ink data must often be set to Overprint Fill in 
Attributes. (See Figure 11.) 

Figure 11: Attributes set to Overprint Fill 

 
 

8. Save the file as a PDF file (see Preparing files for saving as PDF). 
 

Using Adobe InDesign CS Series for white ink 
It is usually best to create white art in Illustrator or Photoshop, save it as a PDF 
file, and then open it in InDesign. If there is no White_Ink swatch yet, the 
White_Ink swatch created in the Illustrator file imports with the file. In that 
instance, use the imported White_Ink swatch instead of creating a new one. When 
exporting the final PDF file for printing see the Preparing files for saving as PDF 
section of this document. 
 
To use the white ink function in InDesign, define the areas of white ink in the file. 
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Figure 12: New Swatch - White_Ink 

  
 

1. Click Window>Color>Swatches to open the Swatches palette. (See Figure 
12.) 

2. From the Swatches Palette menu, click New Color Swatch. 
3. Choose Spot Color for Color Type and choose CMYK for Mode. 
4. Name the new swatch White_Ink. 
5. For easy identification, set the swatch color to a color not used in the file. 

As an example, we will use 100% Magenta. This color will translate as white 
at the RIP. 

6. In the file, select the shapes and elements to be white ink coverage. 
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Figure 13: Apply Spot Color - White_Ink 

 
 

Important: White_Ink data must often be set to Overprint Fill in 
Attributes. (See Figure 13.) 

7. Export the file as a PDF. (See Preparing files for saving as PDF). 
 

Choking white ink 
It is recommended to choke white ink that is to be under graphics to keep white 
ink from appearing around the edges. 

Using Adobe Photoshop CS Series to choke white ink 
1. Select the image that will be printed with white. (See Figure 14.) 
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Figure 14: Select the image 

 
 

 

Figure 15: Contract 

 
 

2. Choose Select>Modify>Contract. (See Figure 15.) 
 

3. In the Contract Selection dialog box, enter the value 2 in the Contract by 
field. (See Figure 16.) 
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Figure 16: Contract by two pixels 

 
 

 
4. Select White_Ink layer in the Channel menu, and then choose Edit>Fill. 

(See Figure 17.) 

Figure 17: Edit>Fill 
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5. In the Fill dialog box Contents pane, choose Black from Fill options. (See 
Figure 18.) 

Figure 18: Choose black fill 

 
 
 

Figure 19 shows the result of the fill. 

Figure 19: Fill result 
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6. Save the image as a PDF (see Preparing files for saving as PDF). 

Using Adobe Illustrator to choke white ink 
1. Select the image to be printed with white. (See Figure 20.) 

Figure 20: Select image 

 
 

2. Choose Object>Path>Offset Path. (See Figure 21.) 

Figure 21: Offset Path 
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3. Set amount of path offset in the Offset Path dialog box.  
The amount can vary depending on size and scale of artwork. (See Figure 
22). 
 

Figure 22: Set amount of path offset 

 
 

4. Enter White_ink in the Swatch Name field. (See Figure 23.) 

Figure 23: Apply White_ink spot color swatch 
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5. In the Attributes tab, click Overprint Fill. (See Figure 24.) 

 

Figure 24: Check Overprint Fill 

 
 

6. Save the image as a PDF. (See Preparing files for saving as PDF.) 
 

Preparing files for saving as PDF 
The following are useful guidelines for using different applications to prepare files before 
you save them as a PDF. 

Using Photoshop CS Series to prepare files for export 
If you prepare files using Photoshop CS Series, consider the following: 
 

• For best image quality, the suggested image dpi range at 100% of scale is 100 to  300, 
regardless of printer resolution. Below 100 dpi, the image quality degrades.  

• Above 300 dpi the quality is not enhanced, but the file size is substantially larger. 
• Do not convert Pantone spot colors (channels) to process CMYK. 
• Save the file as a PDF.  

Using Illustrator CS Series to prepare files for export 
If you prepare files using Illustrator CS Series, consider the following: 
 

• Include all embedded/placed/linked images. 
• Convert all fonts to outlines. (This is optional.) 
• Do not convert Pantone spot colors to process CMYK.  
• Save the file as a PDF. 

Overprint Fill 
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Using InDesign CS Series to prepare files for export 
If you prepare files using InDesign CS Series, consider the following: 
 

• Convert all fonts to outlines. (This is optional.) 
• Export the file as a PDF. 

Saving files as PDF and PDF presets 
Before you save files, consider the following: 
 

• These settings are intended to save a 'RIP ready' PDF. Do not use this PDF format for editing 
the art after it is saved. You should make changes to the original art and re-save it using 
these settings. (These settings hold information regarding fonts, working color spaces and 
spot colors.) 

• This procedure outlines creating the Adobe PDF Preset to avoid having to change these 
settings every time you save a PDF. 

• When applying a preset for the first time, it is recommended that you do it from Illustrator. 
This preset will then be available from the entire Adobe suite. 

  
1. When you save a file, select the High Quality Print preset. (See Figure 25.) 

Figure 25: Save Adobe PDF 

 
 
2. Select Compression in the left menu.  
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Figure 26: Disable downsampling and compression 

 
 
3. In the Color Bitmap Images pane, select Do Not Downsample and set the 

Compression menu to None. (See Figure 26.) 

This ensures that you save the highest quality PDF. 

4. Select Output in the left menu. (See Figure 27.)  
Include, Tagged Source Profiles is selected. This will embed the working 
space and/or image files. 

Figure 27: Select Output 

 

Set to Do Not 
Downsample Set to None 

Save Preset  

Select Output 

Select 
Compression 
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5. Click Save Preset in the lower left corner. (See Figure 27.) 
6. Name the preset XF-PDF, and then click OK. (See Figure 28.) 

 

Figure 28: Save as XF-PDF 

 
 
7. Click Save PDF. 
This preset will now be available as an option in the Adobe PDF Preset menu in all Adobe programs. 

Using Fiery XF to print with white ink 
 

Overview: Printing with white ink using Fiery XF 
If your printer supports white printing, you want to handle the printer’s white channel as 
flexibly as possible.  
 
Some printers that support white printing are the VUTEk GS-series, VUTEk QS-series, 
Rastek H650/652/700, Rastek T600/660/1000, EFI Jetrion 4830, Roland VersaUV LEC 
300/330, Mimaki TPC-1000 or any other printer supported by Fiery XF. 
 
Fiery XF provides two main workflows—manual and automatic—for basic white printing. 

Manually preparing XF for your white channel data 
When you import a job that contains spot colors, you can route one or more of the spot color names 
to the printer’s white channel.  
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This is an example that includes spot colors: 

Figure 29: Spot Color example 

 
 
By default, Fiery XF expects the job’s white channel data to have the name 
WHITE_INK, with capital letters and an underscore in between. This name cannot be 
changed. 
 
However, PrePress may have assigned another name to the white channel, or you may 
want to route any spot color to this channel. (This avoids going back to the DTP 
application and adjusting the name.) You can use the Color > Spot Colors tab to route 
spot color to the white ink channel. 
For example, this is how to route all the “red” spot colors to the white ink channel.  
 
1. Click the Color -> Spot Color tab, and then check the job’s spot colors. 
2. In the Source column, choose PRINTER for the red channel.  
3. In the Map column, choose WHITE_INK for the red channel. 
4. Click Save. 
 
The updated preview shows the red spot color as white. 
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Figure 30: Updated Preview 

 
 

Automatically preparing XF for white channel data 
If you know the standard white channel name your PrePress or customer will use, you 
can prepare Fiery XF for these names automatically. 
 

1. Open Color Editor, create a new spot color table, and create as many Aliases 
as you need. 

2. Enter a name for the new spot color table.  You can assign the new spot color 
table to a workflow now or leave it unassigned for now by not selecting a 
workflow.  Click OK to save the new color table. 

Figure 31: New Color Table 
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Figure 32: Color Editor 

 
 

3. Enter any name that you expect for the white spot color channel, for example 
MyWhiteName.  

4. Set WHITE_INK in the Apply as: combo box. (The WHITE_INK entry is 
usually near the bottom of the long list.) 

Note: This routes the white spot color name MyWhiteName to 
WHITE_INK, which clarifies the purpose for Fiery XF. 

5. Repeat this for other names that you want to route to WHITE_INK in the 
same spot color file. 

6. When you are ready, save the spot color definition as a CxF file in the folder 
C:\ProgramData\EFI\EFI XF\Server\Profiles\Spotcolor. 

7. After saving the spot color table you a dialog will be displayed allowing you to 
apply the spot color table to one or more workflows. 

8. Close Color Editor 
9. If you did not apply the spot color table to a workflow can manually apply the 

spot color table later in System Manager. 
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Figure 33: Spot Color Library 

 
 

Save the workflow and repeat choosing applying the spot color table for as many 
workflows as you like. 
 
When you load a job into one of these workflows, the white spot color channel is 
automatically routed to WHITE_INK and the job will be correctly processed and 
printed. 

 

Controlling white after it is assigned 
There are various options for controlling white ink within XF for EFI Inkjet printers. 
 
Most white ink printers Fiery XF supports provide additional control over the white inks. 
To see the available settings, choose Output Device -> Special. If you do not find 
these settings in Fiery XF check whether the device type selected in the Device Tab 
includes “White” in the name.  If it does not, select a device type that does include 
“White” in the name. 

Figure 34: Including "White" in name 

 
 

Setting a print mode 
Set a print mode by clicking in the Print mode: menu.  
 
You can choose either Spot color WHITE_INK, Inked_Image, Bounding box, Inked 
Image Inverse or Off. Spot color WHITE_INK is the default mode. Fiery XF sends 
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the image data in the WHITE_INK channel, or any channel assigned to WHITE_INK, 
to the printer. 
 
Inked_Image automatically creates a white channel and white image data and 
sends it to the printer. Fiery XF analyzes the image data, and any image element 
that is not CMYK 0 0 0 0 (media white) will receive data in the white channel at the 
same position. For example, if you print a job that consists of a tree on a white 
background, Fiery XF generates white on top or below the tree, but not anywhere 
else. You do not need to go back to the DTP application to generate this layer 
manually. Also, if the job already includes a white channel with white image data 
and you select Inked_Image instead of Spot color WHITE_INK, Fiery XF combines 
the white image from the job’s white channel and the generated white image data 
from “Inked image”. 
 
Inked image inverse automatically creates a white channel and white image data 
and sends it to the printer. Fiery XF analyzes the image data, and any image 
element that is CMYK 0 0 0 0 (media white) will receive data in the white channel 
at the same position.  Also, if the job already includes a white channel with white 
image data and you select Inked_image inverse instead of Spot color WHITE_INK, 
Fiery XF combines the white image from the job’s white channel and the generated 
white image data from “Inked image inverse”. 
Bounding box creates a white channel and white image data for you and fills the 
complete bounding box with white. 

Setting white ink coverage 
“White ink coverage” allows you to define the white channel’s ink coverage. The default 
is 100%, but if you generated white data with “Inked image”, “Inked image inverse” or 
“Bounding box”, you can print white data with less than 100% white ink coverage. 
In some cases you can apply more than 100% ink coverage for white.  
 
Some printers have predefined media settings that limit white to a certain amount. For 
example, setting 125% white ink coverage tells Fiery XF to use 25% more ink that 
originally targeted by the printer manufacturer for the selected media type. In general, it 
is not recommended to use more than 100% white ink coverage. 

Specifying spread and choke for the White ink 
You can specify either a spread or choke for the white ink by entering a value in the 
edit box. 

Printing the control strips with White ink 
You can specify that either, or both, of the control strips print with White ink by 
checking the checkbox for that control strip. 

Creating a curve to control the White Ink Channel 
You can create a curve to control the tonality of the White Ink channel on VUTEk 
printers.   
 

1. Open Color Tools and click Visual Correction. 
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Figure 35: Visual Correction 

 
 

2. Click Plate compensation in the “Correction type” pane. 
3. Click Spot color in the Gradation pane. 
4. Enter values for In% and Out%.  (Enter the values after the entry for 100%.) 
5. Click an empty cell when finished to enter the new values.  Do not change any other 

settings in the dialog box, as this may produce unexpected results. 
6. Click OK to save the curve. Click on Exit to close Color Tools. 

By default, Color Tools creates the curve in the Working directory. 

Figure 36: Color Tools 

 
 

7. In System Manager, select the desired workflow. 
8. Click the Color tab, and then click Color management. 
9. From the Plate Compensation menu, choose the curve created in Color Manager. (You 

may have to scroll to the bottom of the dialog box to see the menu.) 
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Figure 37: Plate compensation 

 
 

10. Save the changes. 

Note: You can use a curve. 
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